
DRAWING ( CRTANJE ) 

 

Crtanje sa pen tool - om  ( alatom pera ) omoguđava kreiranje finih pravih i 

zaobljenih  linija sa velikom preciznošću. Crtati možemo i sa  pencil tool – om ( olovka 

alatom) s kojom možemo ctrati kao po papiru. Ona je najpogodnija za skiciranje i kreiranje 

posebnog stila. Prvo selektujemo  pencil tool  sa ponuđenog menija, zatim obiljeržimo gdje 

želimo da započnemo crtanje nekog oblika, i povlačimo linije, tada će se početi pojavljivati 

mali x – evi, od kojih možemo povlačiti niove oblike i linije. Da bismo nacrtali zatvorenu 

putanju sa pencil tool – om selektujemo pencil tool pozicioniramo gdje želimo da počne 

putanja, i onda vučemo kuda želimo da se putanja kreće. Kada povlačimo istovremeno 

možemo pritisnuti tipku ALT na tastaturi i pojaviće se malo povećalo i gumica za brisanje . 

Kada je putanja oblika i veličine kakvu mi hoćemo da bude, onda pustimo dugme na mišu, ali 

ne i tipku ALT, nakon što se putanja zatvori u željenom obliku pušta se tipka ALT.  
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Povezivanje teksta kroz okvire 
 
 

Možete povezati okvire u jednu cjelinu, bez obzira da li oni sadrže 
tekst ili ne. 
Možete dodati automatski "continued on" ili "continued from"opcije, 
koje prate povezane dijelove jedne iste priče, dok oni prelaze iz 
jednog okvira u drugi. 
 
Da biste dodali novi okvir za povezivanje potrebno je da: 
1. Koristeći alat za selektovanje, odaberete okvir a zatim kliknete 

na onaj port u koji se uvozi ili onaj u koji se tekst nastavlja, da 
biste napravili ikonu za tekst. Klikom na ulazni port, InDesign 
dozvoljava da dodate okvir prije selektovanja ve' postojećeg 
okvira,  klikom na izlazni port, dodajete okvir nakon što ste 
selektovali prethodni okvir. 

2. Postavite pripremljenu tekst ikonicu na mjesto gdje želite da se 
pojavi sljedeći okvir, a zatim kliknite i vucite da biste napravili 
novi okvir. 

Kada je nova tekst ikona aktivna, možete izvesti mnoge opcije, 
uključujući okretanje stranica, zoom in i zoom out. Ukoliko 
napravite vezu između dva okvira i predomislite se, možete otkazati 
napravljenu "vezu" klikom na bilo koji alat u TOOL BOX-u. Tekst će 
pri tom biti sačuvan. 
 
Da biste dodali već napravljeni okvir u lanac, potrebno je da: 
 
1. Koristeći alat za selektovanje, odaberemo okvir a zatim kliknemo 

na ulazni ili izlazni port da bismo ubacili tekst ikonu (tekst). 
2. Postavite ubačeni tekst preko okvira u kome će se nalaziti 

nastavak teksta. Ubačeni tekst se tada pretvara u ikonu za 
povezivanje (thread icon). 

 
(Uz ubačenu ikonu za povezivanje teksta, kliknite na okvir u koji 
želite da ubacite tu "thread" ikonu) 
 
3.   Kliknite unutar drugog okvira da biste ga povezali sa 
prethodnim. 



Da bismo povezali tekst radimo 
sledeće. Iz padajućeg menija VIEW   

odaberemo SHOW TEXT THREADS.  
Sa alatkom za selekciju selektujemo bilokoji frejm u tekstu. Ako 
želimo da povežemo dva različita teksta tada Shiftom i klikom 
selektujemo po frejm u svakom tekstu. Da bismo isključili 
povezivanje teksta ponovo iz menija VIEW izaberemo opciju HIDE 

TEXT THREADS i povezivanje je 
"sakriveno", isključeno.  

 
1. Da bismo razdvojili dva povezana teksta alatkom za selekciju 
kliknemo na tačku završavanja teksta ili početak koji predstavljaju 
vezu sa drugim frejmom. Na primjer u vezi sa dva frejma kliknemo 
ili na zadnju tačku prvog frejma ili na početnu tačku drugog frejma.  
 

2. Pozicionirajte tekst ikonu preko 
prethodnog ili sledećeg frejma da 
biste prikazali """nepovezanu 
ikonu". 
 
3. Kliknite na frejm, InDesign će 

da prekine vezu između dva frejma.  
 
Takođe je moguće dvostrukim klikom na početnu ili završnu tačku 
teksta raskinuti vezu među frejmovima.  
 

• Dodavanje frejma unutar sekvence povezanih frejmova: 
 
1. Alatkom za selekciju kliknemo na 
završnu tačku prvog teksta gdje 
želimo da ubacimo frejm. Kada 
pustimo dugme miša pojaviće se 
tekst ikona.  
 
2. Drag (drag & drop)da bismo 
kreirali novi frejm ili izaberemo novi 
frejm. InDesign u ovom slučaju 
povezuje frejmove u nizu 
sadržavajući priču.  

 
 



• Raskidanje frejma iz veze: 
 

1. Upotrebom alatke za selekciju izaberemo jedan ili više frejmova 
(shift+klik da izaberemo više objekata) 
 
2. Iz padajućeg menija EDIT izaberemo opciju CUT  
U ovom slučaju frejm ili frejmovi nestaju a sav tekst koji se nalazo 
unutar njih prelazi u sledeći frejm u tekstu. Kada želimo da 
poništimo poslednji frejm u nizu , tekst koji se nalazio u njemu biva 
sačuvan u prethodnom frejmu. 
 
3. Ako želimo da negdje drugdje u našem dokumentu upotrijebimo 
izbrisani frejm tada odemo na mjesto gdje želimo da umetnemo 
poništeni frejm i komandom Paste ga postavimo na željeno mjesto.  
"Pejstovani" frejm sadrži kopiju teksta kojeg je prvobitno obuhvatao 
ali više nije povezan sa tekstom u kojem se prije nalazio.  
 
Iako je frejm ili frejmovi odstranjeni sa kopijom teksta, tekst u 
našem prvom nizu frejmova  nije odstranjen. Kada seriju povezanih 
frejmova (cut i paste) "izrežemo i ubacimo na drugo 
mjesto"odjednom, pejstovani frejmovi će zadržati vezu jedan sa 
drugim ali će izgubiti vezu sa frejmovima it teksta u kojem su se 
prvobitno nalazili u sekvenci.  
 
       Jelena Vasiljević 



Ruleri 
 
 
 
Ruleri su lenijari  koji  se pojavljuju na svakoj stranici.  Oni omogućavaju 
preciznije postavljanje objekata na željeno mjesto. Oni mogu biti  vidljivi i l i  
skriveni na ekranu ali  se ne pojavljuju prilikom štampanja.  
 
 
 
 
 
 
Da biste prikazali  i l i  sakrili  rulere  
na stranici izaberite  
View > Show/Hide Rulers  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Jedinice mjerenja i  ruleri  
 
Za mjerenje možete izabrati  jednu od nekoliko standardnih jedinica. Mijenjanje 
jedinice za mjerenje  ne utiče na položaj objekta na stranici.   
Moguće je podesiti  i  različ i te jedinice kod vertikalnog i  horizontalnog rulera. 
 
 
 
 
 



Željene jedinice za mjerenje možete podesiti  na dva nač ina. 
 

I 
 

Izaberite:  Edit > Preferences > Units & Increments ,  pojaviće se:  
 

 
 

 
Kod Horizontal i  Vertical  padajuće liste izaberite jedinicu za mjerenje koju 
želite da koristite za horizontalni i  vertikalni ruler,  dijalog prozore, i  
palettes .  Ako izaberete Custom ,  ukucajte broj tačaka nakon koje će ruler 
pokazati  glavnu naznaku. 
Pritisnite OK .  
 
 II 
Sekundarnom tipkom miša kliknite na ruler koji  želite da promjenite i  
izaberete željenu jedinicu.  
 
 
 
 

 
 
 
 
 
 



Da biste privremeno koristili  drugu mjernu jedinicu: 
  
Označ i te postojeću vrijednost u palette i l i  dijalog prozoru i  ukucajte novu 
vrijednost iza koje stavte oznaku željene jedinice.  
 
Jedinica:   oznaka:   Primjer  
Inč    i  or in or inch  5.25i 
Milimetar  mm    48mm 
Picas   p    3p 
Points  p (prije vrijednosti) p6 
Picas i  points p (poslije vrijednosti) 3p6 
Ciceros  c    5c 
 
 
 
 
 
 
 
 
 
 
 
Mijenjanje nulte tačke na rulerima 
 
Nulta tačka se nalazi u gornjem lijevom uglu stranice, u ravnini prve linije.   
Možete je pomijerati  da biste izmjerili  daljinu il i  olakšali  mjerenje objekata i  
njihovo pravljenje.  
 
 
Da biste pomjerili  nultu tačku: 

- Kliknite na kvadratić ,  koji  spaja rulere, u gornjem lijevom uglu stranice, 
(1) 

-  povucite na mjesto gdje želite da postavite nultu tačku. (2) 
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Da biste vratili  nultu tačku na pravo mijesto: 
Dvostruki klik na kvadratić  koji  spaja rulere. 
 
 
 
Da biste onemoguć i l i  mijenjanje nulte tačke: 
Sekundarnom tipkom miša kliknite na kvadratić  koji  spaja rulere i  izaberete 
Lock Zero Point or Unlock Zero Point (zaključavanje nulte tačke ili  
otključavanje nulte tačke) 
 
 
 
 
 
 
 
 
 



Već napravljenim putanjama možete dodavati ili izbrisati krajnje tačke linija. Otvorenu putanju možete 
produžavati dodavanjem linija ili povezati dvije otvorene putanje. Alatka olovka se, kada je postavite 
na putanju, automatski mijenja na alatku dodavanje tačaka       ili brisanje tačaka. 

 
Dodavanje i brisanje tačaka 
Dodavanjem tačaka možete lakše kontrolisati putanju ili mijenjati njene dijelove. 

-   izaberite alat direktni odabir(     ), i kliknite na putanju kojoj želite dodati tačku (1).  

-   izaberite alatku olovka   i postavite na mijesto gdje želite da dodate tačku pokazaće se    , i kliknite 
(2,3).  

Da biste promijenili oblik putanje:  

nastavite držiti pritisnutu tipku na mišu, zatim oblikujte liniju pomoću linija za određivanje pravaca (4);  

ili  

držite pritisnuto Ctrl na tastaturi i tipku na mišu (5); 

1 2 3  4 

5 

 

Brisanjem tačaka možete izmjeniti oblik putanje. Kada izaberete željenu putanju (1), izaberite alatku 
olovka i postavite je na tačku koju želite da obrišete (2) i kliknite (3). 

 

1  2  3 

 

Da biste zaobišli dodavanje ili brisanje tačaka na putanji pritisnite Shift kada postavite alatku olovka na 
putanju. Ova funkcija je korisna ukoliko želite da započnete pravljenje nove putanje preko napravljene. 

 

 

 

 



Produživanje putanje 
Da biste produžili putanju:  

-   izaberite alatku olovka i postavite je na krajnju tačku putanje, pojaviće se        , (1)  

-   kliknite i povucite ili postavite alatku na mjesto gdje bi trebala da se završava putanja (2) i kliknite  
ponovo (3).  

 

1  2  3 

 

 
Povezivanje dvije otvorene putanje 
Da biste povezali dvije otvorene putanje:  

-   izaberite alatku olovka i postavite je na krajnju tačku jedne putanje i kliknite (1),  

-   zatim alatku postavite na tačku druge putanje, pojaviće se        (2), i kliknite (3). 

Na isti način zatvara se otvorena putanja. 
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Da biste oštri ugao putanje napravili zaobljnem i obrnuto:  

-   izaberite željenu putanju  

-   izaberite alatku promjena pravca (    ) ili ako je odabrana alatka direktan pravac (    ), pritisnite i    
držite Ctrl + Alt ili ako koristite alatku olovka (   ) pritisnite i držite tipku Alt, 

-   postavite alatku promjena pravca na tačku koju želite da promjenite (1),  

-   povucite linije za određivanje pravca prema van (ako želite da zaoblite oštri ugao) (2),  

 ili 
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kliknite na tačku zaobljene linije (ako želite da napravite oštri ugao) (4) 

 

4  5 

 

 
Rad sa alatkom makaze  
Aklatku makaze koristimo za razdvajanje putanje na dva dijela.  

-   izaberite alatku makaze  

-   postavite na željeni dio putanje i kliknite (1) 

-  izaberite alatku direktan pravac (2) i povucite odvojeni dio na željeno mjesto (3). 

 

1  2  3  
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STROKE 
 
 
 
WINDOW > STROKE 
 
 
 

 
 
Opcijom Sroke definišete debljinu i oblik putanje, oblik krajnjih tačaka i uglova i sl.  
 
 
 
Opcije:  

Weight – odabir debljine putanje.  
Cap – odabir izgleda krajnjih tačaka (u ravnini tačke (1); polukružno (2); preko tačke (3)) 

 

1  2 
 

   3 
 
 
 
 
 
 
 
 
 
 
 
 



 Miter Limit – odabir oštrine uglova, (moguće samo kod oštrih uglova) 
 Join – odabir izgleda uglova (oštro (1); polukružno (2); koso (3)) 
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 Type – odabir izgleda putanje: 
 

- Thick – Thin – Thick – Debela – tanka – debela linija  
- Thin – Thick – Thin – Tanka – debela – tanka linija  
- Thick – Thick – Debela – debela linija  
- Thick – Thin – Debela – tanka linija   
- Thin – Thick – Tanka – debela linija   
- Thin – Thin – Tanka – tanka linja   
- Dashed – Isprekidana linija   
- Solid – Puna linija   
 
Solid izgled je automatski podešen. 
 

 
Kada izaberete Dashed pojaviće se dio gdje možete sami odabrati dužinu svake 
isprekidane linije (Dash) i dužinu razmaka između njih (gap). 

 

 
 

 
 
 
 
 



Start – odabir izgleda početka putanje 
 

- None – Normalan 
- Bar – Zaustavna linija 
- SquareSolid – Puni kvadrat 
- Square - Kvadrat 
- CircleSolid – Puni krug 
- Circle – Krug 
- Curved – Strelica 
- Barbed – Strelica 1 
- TriangleWide – Široki trokut 
- Triangle – Trokut 
- SimpleWide – Široka strelica  
- Simple – Strelica 
 

End – Odabir izgleda kraja putanje  
Isti  oblici kao kod opcije Start 

 
 
 
 
CORNER EFFECT 
 
OBJECT > CORNER EFFECTS  
 

  
 
 
Opcijom CornerEeffects određujete izgled uglova putanje ili objekta.  
Iz padajuće liste opcije Effect odaberite željeni izgled, dok se u polje opcije Size unese veličina izgleda 
koji se primjenjuje na objektu.  
 
Postojeći izgledi su:  
 
 

      
  None      Fancy     Bevel      Inset     Inverse     Rounded 

  Rounded 



Masteri 

Master je kao pozadina {background}koju mozes brzo upotrebiti za vise stranica. 
Master se moze nalaziti na jednoj stranici ili na vise njih. Masteri se koriste za objekte ili 
vodice, kao sto su margine, kolone, brojevi stranica, ponavljanje logoa ili umetnickih 
dela koji se nalaze na istoj poziciji na vecem broju strana. Koristenje mastera moze 
uveliko smanjiti vreme koje vam je potrebno za rad na nekom dizajnu.A ako zelite da 
promenite poziciju nekog objekta na masteru je potrebno samo jednom da to uradite.  

Mozete brzo napraviti komparaciju razlicitih idejnih resenja kreiranjem razlicitih 
mastera, spajajuci ih, dobijate posve drugacija resenja. 

 

Kreiranje i pam}enje mastera 

Masterima se upravlja u master sekciji (gornji deo; Slika 1.) palete stranica. Svaki 
master ima ime i prefiks po kojem se zna koje stranice koriste taj master. 

 

A- Master ikone u gornjem delu palete stranica 
B- Prefiks mastera i ime 
C- Prefiksi stranica zapam}enih mastera 
 

Slika 1. 
 
- Kreiranje novog mastera za vi{e stranica: 
Pritisnite Ctrl (Windows) ili Command (Mac OS) i kliknite dugme Nova Strana  iz 

palete stranica. 
 
- Kreiranje mastera iz vec postoje}e strane ili vi{e njih 
Prevuci celu stranicu (ve} postoje}u) iz sekcije stranica u master sekciju. Svi 

objekti originalne stranice posta}e deo novog mastera. Ako originalna strana koristi 
master, novi master je baziran na originalnom masteru te strane. (Slika 2.) 

 
 
 



 
Slika 2. 

 
 

- Kreiranje novog mastera i unapred postavljanje opcija za njega  
1. Izabrati novi master (New Master) u meniju palete 
2. Ozna~iti slede}e opcije i kliknuti OK: 
• Za prefiks, ukucaj prefiks koji identifikuje zapam}eni master svakoj stranici 

iz palete. ne sme biti ve}i od 4 karaktera 
• Za ime, ukucaj ime za master 
• Za bazni master, izaberi ve} postoje}i master na kojem }e{ bazirati ovaj, 

ili nemoj nista izabrati. 
• Za broj stranica, ukucaj onoliki broj stranica koliki tebi treba. 
 
- Dodavanje opcija na ve} postoje}i master 
1. U master sekciji klikni ime ispod mastera da bi izabrao celi master 
2. Izaberi master opcije za (Master Otions For) u meniju palete strana. 
 
- Pam}enje mastera u dokumentu 
Uradi slede}e: 
• Da bi sa~uvali master u stranici, dovucite ga (drag) iz master 

sekcije na ikonicu stranice u sekciji stranica, i kada se pojavi crni okvir na ikonici pustite 
mi{. 

• Da bi sa~uvali master u vi{e stranica, dovucite ga iz master 
sekcije na broj stranice u sekciji stranica. Kada se pojavi crni okvir pustite mi{. 

 
 

 
Slika 3. 

 
 

- Pam}enje mastera u vi{e stranica 
1. U sekciji stranica odaberi stranice u kojima `eli{ da sa~uva{ novi master 
2. Uradi slede}e: 
• Ako ste odabrali stranice, pritisnite Alt (Windows) or Option (Mac OS) 

kada kliknete master. 
• Ako niste odabrali stranice, kliknite Sa~uvati master (Apply Master) na 

stranice u sekciji stranica, izaberi master da ga sa~uva{. Mo`e{ ukucavati brojeve 
stranica koriste}i sekciju brojeva, mogu se odvajati i slagati zarezima. 



  
 

 
Slika 4. 

 
 

- Spajanje jednog mastera sa drugim 
Ovo je mo}an na~in spajanja dva mastera, da ne biste morali dodavati jedan po 

jedan. (Slika 5) 

 
Slika 5. 

 
U master sekciji, uraditi slede}e: 
• izaberi master i izaberi opcije mastera (Master Options) u meniju palete stranica. 

Za spajanje mastera (For Based on Master) izaberi, drugi master, i klikni OK. 
• Dovuci master sa kojim o}e{ da spaja{ drugi, i ako ho}ete da se spiju samo 

master onda spustite ga na ikonicu, a ukoliko ho}ete na sve stranice onda ga ispustite 
na brojeve stranica. Kada ga dovu~ete ne pu{tajte dok se ne pojavi crni okvir oko 
ikonice. 

 
 

 
Slika 6. 



Grids 
 
 
Grids – su mreže koje se pojavljuju na stranici.  Oni mogu biti  vidljivi i l i  skriveni na 
ekranu ali  se ne pojavljuju prilikom štampanja. Postoje dvije vrste mreže: Baseline 
grid i  Document grid .   
Baseline grid služi za prvilno i  lakše postavljenje teksta (1).   
Document grid služi za pravilno postavljanje objekata (2).  
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Da biste prikazali  i l i  sakrili   
mreže na stranici izaberite:  
View > Show/Hide Baseline Grid  
   i l i  
View > Show/Hide Document Grid  
 
 
 
 
 
 
 
 
 
 
 



 
Da biste podesili  Baseline Grid: 
 
 
Izaberite File > Preferences > Grids, pojaviće se: 
 

 
 
 

-  Iz padajućeg menija Color izaberite boju u kojoj će se pojaviti  l inije.  Boju 
takođe možete izabrati  klikom na Other  i l i  dvostrukim klikom na obojeni 
kvadratić .   

-  U polje Start unesite vrijednost da biste odvojili  grid od vrha stranice. Ako ne 
možete postaviti  grid uz vertikalni ruler,  počnite sa '0 '  

- U polje Increment Every  unesite vrijednost za razmk između linija.   
-  Iz padajućeg menija View Threshold izaberite i l i  ukucajte postotak povećanja, 

kako bi l inije  izgledale preglednije za rad.   
- Pritisnite OK .  

 
 
 
 
 
 
 
 
 
 



 
Da biste podesili  Document Grid  
 
 
Izaberite File > Preferences > Grids,  
 

 
 
 

-  Iz padajućeg menija Color izaberite boju u kojoj će se pojaviti  l inije.  Boju 
takođe možete izabrati  klikom na Other  i l i  dvostrukim klikom na obojeni 
kvadratić .   

-  U polja Gridline Every unesite vrijednost za razmak između glavnih, 
horizontalnih i  vertikalnih, l inija 

- Polja subdivisions određuju broj sporednih linija unutar glavnih 
 

 
 
 
 
 
 
 

Sanja Milanović  
 



Frejmovi  Frames 
InDesign 

 
 
 
 
 
Sav tekst u Adobu InDesign-u se nalazi unutar nekog ograni~enog prostora zvanih 
frejmovi (frames). Kao i grafi~ki frejmovi, tekstualni frejmovi mogu biti pomerani, 
smjanivani, pove}avani... Alat koji koristite da izaberete frejm odre|uje kakvu promenu 
mo`ete napraviti. Alat za uno{enje teksta u frejmove je (T). Crni pointer  se koristi za 
pomeranje i menjanje veli~ine frejma. A beli pointer se koristi za menjanje oblika samog 
frejma. (Slika 1.) 

 
 

 
Slika 1. 

 
 

Uno{enje frejma na dokument se tako|e vr{i sa alatom za uno{enje teksta (T). Oznaci 
se kocka koliki hocemo da nam bude frejm, a kasnije ga naravno mo`emo dora|ivati, i 
pointerima, a i ako odemo u Frames Options (Slika 2.). Na slici vidimo da mo`emo 
pode{avati: broj kolona, veli~inu kolona, unutra{nje margine. 

 
Slika 2. 

 



 
Frejmovi imaju jo{ jednu odli~nu mogu}nost, a to je povezivanje dva razli~ita frejma (u 
jednom po~inje tekst u drugom se nastavlja). Svaki frejm ima jedan izlazni i ulazni port. 
Dakle, ako kliknemo  

 
 
 
 

      
     Slika 3.         Slika 4. 
 



 
 

WRAPPING - POSTAVLJANJE TEKSTA OKO SLIKE 
 
 

Prvo što moramo da uradimo je da aktiviramo paletu TEXT WRAP, koju 
izaberemo iz padajućeg menija WINDOW.  Na radnom polju nam se pojavi 
aktivirana paleta.  

 
Na strelicama koje se nalaze ispred slova TEXT   
WRAP imamo mogućnost otvaranja i 
zatvaranja palete. 

 
 

 
Da biste postavili tekst oko slike, potrebno je da:  
 
1. Odaberete okvir - najčešće slike oko koje želite da stavite tekst, 

koristeći opciju TOOL ili direktnim odabirom alata za rad ili... 
2. Kliknete na dugme za željeni oblik okvira u TEXT WRAP paleti: 
 

 
WRAP AROUND BOUNDING BOX je prva opcija koja 
pravi kvadrat čije su visina i širina određene 

okvirom selektovanog objekta, što nam je 
pojednostavljeno i samim simbolom na dugmetu za 
aktiviranje ove opcije. Tu imamo mogućnost 
podešavanja   odstojanja   teksta   od   slike unosom 
adekvatnih razmjera u polja namjenjena za to.  

 
 

WRAP AROUND OBJECT SHAPE, opcija poznata i 
pod imenom CONTOUR WRAPPING, stvara okvir od 

teksta koji je istog oblika kao i okvir koji ste prethodno 
selektovali. Jedina razlika je u obliku predmeta oko kojeg 
tekst treba da se "obavije". U ovom slučaju oblik 
predmeta nije pravougaonik i tekst se prilagođava tijelu 
predmeta.  Nastavite sa procedurom, kako biste 
definisali opcije za konture okvira... 

  



 
 
 
1. JUMP OBJECT opcija sprečava da se tekst 
pojavi na bilo kom slobodnom prostoru udesno 
i ulevo od okvira, tj. preskače objekat i 
postavlja tekst samo iznad i ispod njega.   
 
 
 
2. JUMP TO NEXT COLUMN opcija prisiljava 
sledeći paragraf da se prebaci na vrh sledeće 
kolone teksta ili okvira teksta. 
 
 

3. Pozitivne vrednosti i parametri pomeraju "obavijanje" (wrap) dalje od 
ivica okvira, a negativne vrednosti pozicioniraju WRAP unutar ivica okvira. 
Da biste postavili TEXT WRAP oko slika na MASTER (glavnoj) stranici, 
upotrebite kombinaciju tipki Shift + Ctrl (WIN) ili COMMAND + Shift (MAC) 
i kliknite na sliku u dokumentu. Zatim na  selektovanoj slici na stranici 
dokumenta primenite opciju TEXT WRAP. 
 

  



Da biste precizirali vrednosti text wrap konture, potrebno je da učinite 
sledeće: 
1. Ako je neophodno, odaberite WINDOW - TEXT WRAP opcije da bi vam 

se prikazala TEXT WRAP paleta, a zatim selektujte sliku koju ste uveli. 
 
2. U okviru TEXT WRAP palete, odaberite opciju WRAP TEXT AROUND 

OBJECT SHAPE i detaljnije odredite vrednosti. 
 
3. Kako biste detaljnije odredili vrednosti, 

odaberite jednu od ponuđenih opcija u TYPE 
meniju TEXT WRAP palete: 

 
 
� BOUNDING BOX je opcija koju koristite da biste postavili tekst oko 

kvadrata određenog visinom i širinom same slike. 
 
� DETECT EDGES - opcija koju koristite da biste stvorili ivice za TEXT 

WRAP, koristeći automatsko traženje ivica. 
 
� Da biste proizveli TEXT WRAP od ALFA KANALA sačuvanog sa slikom, 

odaberite opciju ALPHA CHANNEL, a zatim odaberite kanal koji želite da 
koristite u Alpha Channel meniju na TEXT WRAP paleti. Ukoliko opcija 
za alfa kanal nije dostupna, ni jedan alfa kanal nije sačuvan sa slikom. 
InDesign automatski prepoznaje postavljenu transparentnost određenu 
unutar PhotoShopa kao alfa kanal. U suprotnom, morate koristiti Photo 
Shop da obrišete pozadinu ili napravite, i sačuvate jedan ili više alfa 
kanala sa slikom. 

 
� Da biste proizveli TEXT WRAP vezu od staze sačuvane sa slikom, 

odaberite opciju PHOTOSHOP PATH, a zatim i stazu koju želite da 
koristite u okviru path menija na TEXT WRAP paleti. Ako PHOTOSHOP 
PATH opcija nije dostupna, znači da ni jedna staza nije sačuvana sa 
slikom.  

 
� Da biste napravili text wrap vezu od označenog okvira, koristite opciju 

GRAPHIC FRAME. 
 
� SAME AS CLIPPING opcija - koristi se da se clipping veza uvede na slike 

i iskoristi kao text wrap veza. 
 
� Da biste dozvolili da se text pojavi unutar "rupa" u 

uvedenoj slici (kao što je slika gume), odaberite 
opciju INCLUDE INSIDE EDGES na text wrap paleti. 
Kada je aktiviramo tekst se pojavljuje i unutar 
"rupe". 

 
 

 

  



Da biste kreirali "wrap" unutar i izvan objekta: 
 
1. Koristeći alat za selektovanje ili alat za direktno slektovanje, odaberite 

objekat kao što je složena staza, kako bi vam bilo dozvoljeno da 
ubacite tekst unutar njega. 

 
2. Ako je neophodno, odaberite opciju WINDOW/ TEXT WRAP, da biste 

videli Text Wrap paletu i upotrebili obavijanje tekstom uz opciju 
OBJECT SHAPE. 

 
3. Odaberite opciju INVERT. INVERT je opcija koja se 

najčešće koristi u kombinaciji sa opcijom  OBJECT SHAPE. 

 
 
Da biste promenili oblik teksta koji obavija sliku: 
 
1. To možete učiniti koristeći sekundarni alat za selekciju, odabirući 

objekat koji je obavijen tekstom. Ukoliko je tekst koji obavija istog 
oblika kao i objekat, veza je sigurno primenjena na objekat. 

2. Koristite alat za crtanje (olovka) i alat za direktno selektovanje, da 
prikažete vezu između objekta i teksta koji je oko njega. 

Jelena Vasiljević 

  



CRTANJE STANDARDNIH OBLIKA 

I PRAVIH LINIJA 

 
Brzo i jednostavno se mogu kreairati jednostavne putanje kao što su linije, elipse, koristeći 

alate, alat box (toolox). toolbox takođe sadrži alate za kreiranje istih oblika. Da bi precizno 

radili sa putanjom možemo odabrati WINDOW pa TRANSFORM paletu , kako bismo 

izabrali veličinu i poziciju putanje kako jue povlačimo.  

 
 

 

CRTANJE PRAVE LINIJE,  

PRAVOUGAONIKA, ELIPSE 

 

 U toolboxu odaberemo linijicu , elipsu pravougaonik ili šestougao. Ako želimo ram ili 

frame posebnog oblika u toolboxu odaberemo ili elipsu frame ili pravougaonik frame . Ako 

želimo da crtamo iz centra objekta trebamo držati tipku ALTkada povlačimo mišem.  
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MJEŠANJE KRIVIH LINIJA, UGLOVA I PRAVIH LINIJA  

 

  Da bismo nacrtali prave linije koristimo pen tool kliknemo tačno na obilježenu tačku  

iz pen toola izaberemo convert – point icon ili pero sa malm strelicom da lakše 

poyicionirali, a yatim vučemo u željenom pravcu. 

 

 
Isti je postupak iya iskrivljene linije samo još iy toolboxa izaberemo pen anchor .  

 

 

SELEKTOVANJE OBJEKATA 

 
 Prije nego što počnemo sa oblikovanjem objekta moramo ga selektovati u tool- u . Iz  

toola iyaberemo crnu deblju strelicu koja služi za pozicioniranje i određivanje veličine 

objekta. Sljedeća alatka je bijela strelica iy tool – a koja služi za preciznije određivanje frejma 

putanja i za pomjeranje.  
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